
USING THE SCREEN BUILDER PROGRAM 
 
INTRODUCTION 

 
The Screen Builder program allows you to create and modify files with the extension “MY”.  “MY” files, 
along with “MAP” files and “LAB” files, define dialog boxes for use in CHEMCAD.  Dialog boxes allow 
users to set variables for unit operations.  These dialogs are used with all types of unit operations (called 
“unitops”).  Using the Screen Builder program, users may create custom dialogs to be used with 
calculator units, excel units, or user-added units.  This document is to give you an overview into how the 
Screen Builder program is used.  This document assumes a basic understanding of Windows and of 
Visual Programming concepts such as objects and properties, as well as a firm understanding of 
simulation in CHEMCAD. 

Screen Builder is a separate program from CHEMCAD.  To open this program, go to the “START” 
button, then to “Programs” then to “CHEMCAD” and finally to “Utilities”.  Select the “Screen Builder” 
program.  You may also start this program from CHEMCAD, go to the “Edit” menu, and select “Screen 
Builder” and it will open the Screen Builder program. 

HOW UNIT OPERATION DIALOGS WORK: 
Unit operations in flowsheets usually require operating parameters to run, like “Operating Pressure” for 
example.  These parameters are entered into dialog screens.  The dialog screen stores the parameters 
in an array for each unit operation.   The arrays are passed to the calculation block when the unitop is 
run. 

 
 
 
 
 
 

As you can see data transfer goes in both directions, meaning that calculated results for a unit are 
passed to the dialog in the same way that data is passed from the dialog into CHEMCAD.  The Unitop 
Parameter Array performs any data conversions necessary, so that you might enter a value of 100 
degrees Fahrenheit in a dialog, but the program sees a value of 559.67 degrees Rankine.  

A dialog box (or screen) is used by CHEMCAD to set operating parameters for unit operations in a 
flowsheet.  Dialog boxes are stored in three separate files.  Files with the extension “MY” define the 
visual aspect of the dialog.  Files with extension “MAP” define the data connections from the dialog box 
back to the unitop array.  Files with the extension “LAB” define report labels and formatting.  These files 
are typically stored either the program directory or the job directory. 
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All unit operations in CHEMCAD use this same dialog box structure.  This means you have over fifty 
examples of unitop dialog boxes to draw from.  All the standard dialog files are stored in the program 
directory (typically “C:\CC5”) as read-only files.  

IMPORTANT:  Do not edit the files in your CC5 directory which are set to read-only, editing these 
files may affect the performance of your simulator.  If you accidentally do this, reinstall 
CHEMCAD to replace the files.  If you wish to look at the files, make a copy of them. 

Creating new dialog boxes is a matter of: 

• Designing the Unitop Parameter Array 

• Creating a “MAP” file and “LAB” file based on the Array, Using Notepad 

• Creating an “MY” file based on the “MAP” file, Using the Screen Builder 

In this manual, we will get started with an example from CHEMCAD, the mixer dialog box.  Then we will 
get started building a unitop parameter array for a very simple dialog.  We will introduce you to the 
various objects in a dialog box, and give some overall design guidelines.  We will then discuss more 
complex topics of screen editing, such as VB scripting. 

THE MIXER DIALOG BOX: (AN EXAMPLE) 

 
Like all other dialog boxes, the mixer dialog is composed of two files, a “MY” file and a “MAP” file.  In this 
case the file names are “MIXE.MY”, “MIXE.MAP”, and “MIXE.LAB”.  “MIXE.MY” may be viewed and 
edited in the Screen Builder program; “MIXE.MAP” and “MIXE.LAB” may be opened by any text editor 
(such as Notepad or Wordpad). 

 

 
The Mixer dialog box 
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In CHEMCAD, the dialog appears as above.  In this dialog, users may set the outlet pressure of the 
mixer.  The “MY” file (which defines the appearance of the dialog box) assigns any value typed in this 
filed to a variable.  The MIXE.MAP file defines that variable to be the first variable in the unitop array.  
CHEMCAD reads the values stored in the unitop array when running the simulation.  We are going to 
examine this screen in detail by examining the “MAP” file and the “MY” file. 

THE MIXE.MAP FILE 
THE MIXE.MAP file defines the variables in the unit operation array which are passed back and forth 
from the dialog to CHEMCAD, and vice versa.  THE MIXE.MAP file is a text file, like all “MAP” files, it 
may be viewed with Notepad.  

 
 
 
 
 
 
 
 
 
 
 

The MIXE.MAP file 

The structure of this file is as follows: 

The first line is the name of the unitop, it is a MIXER.   

The line “DICTIONARY 8” defines the array to have 8 members.   

The next 8 lines define the members of the array.  The first line describes a variable “OPRESS”, which is 
the first element in the array, a floating-point double precision number, and it has units of pressure.  A 
complete list of units is given in Appendix A.  The second line describes a variable “FRSTRM”, the 
second element in the array; it is a floating-point long integer type, with no engineering units.  All of this 
will be described at greater length later.  For now, just accept that this file defines an array of 8 numbers, 
the first of which is a floating-point number in the units of pressure. 

Normally the mixer unitop only uses the first parameter “OPRESS” or operating pressure.  All of the 
other variables are only used in AUTOCALC simulations or in electrolyte simulations, so they are 
normally hidden from view in the dialog box. 

THE $MIXE.LAB FILE 
The $MIXE.LAB file defines the report shown when you select “Results\UnitOps” in CHEMCAD.  The file 
format is fixed width text: 

MIXER 
 
DICTIONARY      8 
OPRESS          1       FLOAT   PRES 
FRSTRM          2       FLOAT           LONG 
PSTRM1          3       FLOAT           LONG 
PSTRM2          4       FLOAT           LONG 
PSTRM3          5       FLOAT           LONG 
PSTRM4          6       FLOAT           LONG 
PSTRM5          7       FLOAT           LONG 
PHASE           8       FLOAT           LONG 
�  
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This file is organized into columns and rows.  Each row under the first row defines an entry in the report. 
“Pos.” refers to the data’s position in the Unitop Array.  “Unit” determines the engineering units.  “Type” 
and “Fmat” determine how the number is displayed.  Type=0, Fmat=0 displays a floating point number, 
Type=1 Fmat=0 displays an integer.  “Req.” and “Prn0” are for internal use only and should be left at 0 in 
your LAB files.  “Label” shows the text label given on the report. 

The most important thing to remember about the LAB file is to make sure the “Unit” entries correspond 
with the units displayed in the MAP file.  A complete list of units is given in Appendix A. 

THE MIXE.MY FILE 
Installed with CHEMCAD are a number of utility programs used in conjunction with CHEMCAD.  One of 
these, the Screen Builder program, allows users to edit “MY” files.  To start the Screen Builder, either 
click on the “Screen Builder” item in the CHEMCAD “edit” menu, or start the Screen Builder program 
from the “Start Menu\Programs\CHEMCAD\Utilities” menu of your computer. 

To open an existing MY file, copy the file from C:\CC5 to any temporary area and unmark the “Read 
Only” property of the file.  This will allow us to edit the file.   Choose the “open” command from the “File” 
menu and select the “MIXE.MY” file from your temporary folder. 

Pos. Unit Type Fmat Req. Prn0   Label 
   1    4    0    0    0    0   Output Pressure 
   2    0    1    0    0    0   Back-calc Flow,  input #: 
   3    0    1    0    0    0   Back-calc Press, input #: 
   4    0    1    0    0    0   Back-calc Press, input #: 
   5    0    1    0    0    0   Back-calc Press, input #: 
   6    0    1    0    0    0   Back-calc Press, input #: 
   7    0    1    0    0    0   Back-calc Press, input #: 
   8    0    1    0    0    0   Optional output phase: 
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Run mode of Screen Builder  

This displays the screen in run mode.  Run mode means all visual basic scripting is active, so the screen 
performs much like it will in CHEMCAD.  In order edit the screen, we must enter Edit mode.  To do this, 
go to the “Layout” menu and select “Edit”.  The screen will change appearance to indicate you may now 
edit the dialog box: 
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Editing mode of Screen Builder  

Where did all that come from?  Most of the objects on this dialog are hidden by VBScripts.  VBScripts 
(Visual Basic Script) are simple visual basic code attached to the controls which can do many things, 
including making the object visible or invisible.  Visual Basic Script is discussed later in detail. 

OBJECTS, TEXT, AND CONTROLS 
There’s a lot on this screen, so lets focus on the top section first: 

 

 
Upper part of MIXE dialog  
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This dialog is made of many types of objects.  Each object has it’s own set of properties and code.  In 
the above section, you can find the following objects 

 
Object Name Object Type Sample property of Object 

Text1 Text Text= ”Operating Pressure” 

EditDblBox1 Edit Double Box ValueID=Double001 

TextVar1 Text Variable Value Eq=<Pres Str> 

Text4 Text Text=”ID: “ 

TextVar2 Text Variable Value Eq=<ID> 

 
All of these objects can be selected, moved, shrunk, etc. using the mouse.  Double clicking on an object 
brings up a list of all of its properties. 

Basic object descriptions: 

• Text objects display text; they are used for labels, like the “Operating Pressure” label above. 

• TextVar objects are text which depend upon CHEMCAD.  In the above screen, TextVar1 
displays the current pressure units on the flowsheet.  TextVar2 displays the unitop ID number. 

• Edit Double Box objects are able to store floating-point double precision numbers and pass 
them to CHEMCAD through the unitop array.  EditDblBox1 is set to pass its data through the 
first member of the array.  This is identified in the Screen Builder as the valueID=Double001. 

 
Lower part of MIXE dialog  
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In the middle section of the screen are many objects which vanish during normal runtime.  These 
controls are only used under certain conditions.  Each object has VB script instructing it to be visible only 
if AUTOCALC is on.  A partial list of objects in this section would include: 

 
Object Name Object Type Sample property of Object 

Text6 Text Text= ”For autocalc only, select the input stream(…)” 

ComboBox2 ComboBox ValueID=long002 

Button2 Button ButtonType= OK button 

 

ComboBox is an object, which allows users to pick from a list, and it stores the long integer result in the 
unitop array. 

The [OK] button is a special button, which instructs the dialog box to close and save all data in the 
unitop array.  The Cancel button is next, and will also close the dialog, but will not save changes to the 
array. 

Text objects we’ve seen before, but this one has some Vbscript attached to it.  Double click on the Text6 
object to bring up its properties. 

 
Properties and Events  
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Notice the “Events” tab on the right.  Events show different sections of Vbscript, which run under different 
conditions.  The conditions for which scripts may be written are: 

• EventClick:  Mouse is left clicked over object 

• EventDblClick:  Mouse is double left clicked over object 

• EventDrapDrop:  Object is dragged over another object and released 

• EventDragOver:  Object is dragged over another object 

• EventInitialize:  Dialog is opened 

• EventMouseDown:  Left mouse button is held down 

• EventMouseMove:  Mouse is moved 

• EventMouseUp:  Mouse left button is released 

• EventPumpData:  some other piece of code calls the method “TheView.PumpData” 

For almost all dialogs in CHEMCAD, the only conditions used are “EventInitialize” or “EventPumpData”. 

Getting back to our example above, the “EventInitialize” for Text6 shows some code 
“this.visible=(AutoCalc)”.  This VBScript shows that the text6 text object will only be visible if AutoCalc is 
on.  AutoCalc is a global variable set by CHEMCAD when in AUTOCALC mode. 

Now lets review how these files all work together.  Lets say a CHEMCAD user opens a mixer dialog to 
change its pressure: 

1. The user double clicks on a mixer icon in CHEMCAD. 

2. CHEMCAD finds the unit operation array, as defined by the “MIXE.MAP” file and then opens 
the “MIXE.MY” file. 

3. “MIXE.MY” runs the scripts on all of its internal object’s “EventInitialize” events, causing some 
of the objects to not be visible. 

4. The user sees the mixer dialog on the screen, enters an operating pressure, and clicks the [OK] 
button. 

5. The “MIXE.MY” screen saves the data in the unit operation array and closes itself. 

 
BUILDING A SIMPLE DIALOG BOX 
 
This step-by-step guide will help you create a very basic dialog box with a minimum of effort.  The dialog 
we are going to build is called CALC, and a copy is provided in the CC5\EXAMPLES\DIALOGS directory 
for your reference.  This dialog is for a simple mixer, without all the extras the MIXE files provide.  
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A Simple Dialog Box  

To build this we must take the following steps: 

• Define a MAP file 

• Create a new MY file 

• Edit the dialog 

• Add objects to the dialog 

• Test the dialog 

Step 1:  Define your MAP file. 
The first thing the user must always do is identify the unitop array for this dialog.  We do this by creating 
a MAP file.  As we can see in the picture above, we have only one data entry field, “Operating Pressure”.  
This will be a floating-point double precision number in the engineering units of pressure.  Our MAP file 
is as follows: 

 

 

 

 

 

 

The “OPRESS” label is for our reference only, FLOAT defines a floating-point double precision number, 
and PRES indicates units of pressure. 

Step 2:  Create a new MY file 
Start the Screen Builder program, either from the “Edit” menu in CHEMCAD or from the 
“Programs\CHEMCAD\Utilities” menu under the “Start” button.   Then, go to the “File” menu, select 
“New”.  

BASICDLG 
 
DICTIONARY      1 
OPRESS          1       FLOAT   PRES 
� 
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A new dialog in Screen Builder  

This creates a new dialog in the Screen Builder program.  As you can see, it is labeled “Static Text” and 
has no objects on it.  We will move on to edit this dialog and add objects to it. 

Step 3:  Editing the dialog 
Now we must make changes to the dialog’s properties.  Double click on the dialog to bring up the 
properties for TheFrame/TheView.  We must change the “AutoRecord” Property to “2-Detach”.  This 
property controls how the dialog links to CHEMCAD, and it is the most important setting in your dialog.  If 
you do not set AutoRecord to Detach, your dialog will not work properly within CHEMCAD. 
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Setting the AutoRecord property  

We can also change the title ”Property” to “Basic Dialog (BASICDLG)”.  This title string is for the user’s 
reference only; it is not used by CHEMCAD in any way. 

Close the “Property Sheet” by clicking the small X in the upper right corner. 

Step 4: Adding Objects to the Dialog 
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Now we need to add some objects to the dialog.  To add a text box, click on the text button in the object 
toolbar (the letter “A”).  Now draw a rectangle in the dialog screen.  You have just created a new text 
object called text1. 
 

.  
Creating a text object  

Now we must change the text to “Operating Pressure”.  Double click on the text1object and change the 
text property to “Operating Pressure”. 

Now let’s add a second text object to show the text “ID”.  This is done in the same way as the Text1 
object. 

We will need to add an EditDblBox object.  The EditDblBox button is the 3rd button from the left in the 7th 
row down.  Click this button and draw your EditDblBox in the same way as the text boxes.  Change the 
“ValueID” property of your EditDblBox to “Double001”  
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Setting the EditDblBox properties  

This instructs the dialog to send the data from this control into the first item in the unitop array.  Without 
this setting, there is no link between numbers entered and CHEMCAD.   

Now we will add a few text variables to pick up the pressure units and ID number.  Text Variables appear 
on the palette as “A+” and are created just like text objects.  Place one text variable to the right of your 
EditDblBox, another to the right of the text object “ID”. 
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Placing the Text Variables  

The Text Variable object next to the “ID” text must be set so that it’s “ValueEQ” property is equal to 
“<ID>”.  The Text Variable to the right of the EditDblBox must be set so that it’s “ValueEQ” property is 
equal to “<Pres Str>”.  In CHEMCAD, <ID> is a variable which is set to the unitop ID number, and <Pres 
Str> is set to the value of the current engineering units. 

Now we will add two final objects, the OK and Cancel buttons. To create the buttons, select the button 
icon from the palette and draw the two buttons. 

 

 
Creating Buttons  

Change Button1’s Text to “Cancel” and change it’s ButtonType to “0-Cancel”.  Change Button2’s Text to 
“OK” and it’s ButtonType to “4-OK”.   
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Changing Button Type Properties  

Our dialog is completed, now save it as “CALC.MY” and we’re ready to test . 

Step 5: Testing the dialog 
Testing the dialog is actually a two part process.  First we must test the MY file, to make sure the VB 
scripts (if any) work properly.  We do this by going to the “Layout” menu and unselecting “Edit”.  (You 
can do the same by pressing CTRL-E.)  The toolbars will change and we will be running our dialog.  Our 
simple dialog doesn’t have any VB scripts, but it is always a good idea to run the dialog here before 
trying it in CHEMCAD. 
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Running the dialog in the Screen Builder  

The second part of the testing process is to test the dialog within CHEMCAD.  To do this we must make 
a job with a calculator unit, and copy the CALC.MY and CALC.MAP into the job folder. 

  

 
Creating a test flowsheet in CHEMCAD  
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After creating this flowsheet, copy the MY and MAP files to the job subdirectory.  Now go into “Run 
Simulation” mode and double-click the calculator unit.  Your custom dialog should appear.  Enter a new 
pressure here and press the [OK] button. 

 
Changing the pressure to 32 psia  

Now reopen the dialog box, and the entered pressure should appear as you typed it.  This shows us that 
CHEMCAD stored the number and retrieved it properly.  Now close the dialog again and change your 
engineering units to “psig”. 

 

 
Changing the engineering units 
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When you reenter the dialog, it will change the pressure string to psig and convert the value for you.  
Demonstrating that CHEMCAD recognizes the number you entered as a pressure, thanks to the MAP 
file’s “PRES” entry.  If your dialog does not perform as expected, compare your MAP and MY files with 
those in the example job “Calculator” located in the examples subdirectory in you CC5DATA work folder. 

 
New pressure units 

 
MAP FILES EXPLAINED 
 
MAP files define the unitop array structure, and must be understood before moving on to dialog design.  
MAP files are simple text files, with white space (spaces or tabs) between fields.  MAP files are edited 
with Notepad (Look in your “Accessories” program group under the START menu on your computer), or 
any text editor capable of saving files in a text format. 

 
An example MAP file 
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The first line of the MAP defines the unitop name.  This is normally defined for you, such as “CALC” for 
calculators or Excel units, “ADDx” for User Added Module number x.  After this line, you should add an 
extra line space for separation. 

The next line of data defines the overall size of the array.  “DICTIONARY N” where N is an integer 
between 1 and 300.   

The next lines define each data member of the array.  Each array member may have a name for your 
reference.  The name of an array member may not include any spaces or special characters.  Array 
Members are listed in order from 1 to DICTIONARY.  Arrays members may be either double precision 
real numbers, designated as “FLOAT” or long integers, designated by “FLOAT LONG”.  Array Members 
may have any of the engineering units listed in Appendix A. 

CHEMCAD uses the MAP file to make conversions from your current user-engineering units to the 
Internal units used in the actual code.  Internal units are the engineering dimensions used in 
CHEMCAD’s code, such as pounds, degrees Rankine, or cubic feet.  Here’s how that works.  All the 
code in CHEMCAD was written using a single set of engineering units, as shown above.  But users 
always like working in the units they’re most comfortable with.  The MAP files are used as a convenient 
translation layer between the user units and CHEMCAD’s internal units. 

When you enter a number in a dialog and press the OK button, CHEMCAD checks the MAP file for that 
member of the unitop parameter array to see if it has engineering dimensions (or units).  It then makes 
any conversions needed to store the number converted into internal units. 

 
DIALOG OBJECTS 
 
Any of the following objects may be used in your dialog: 

TEXT OBJECTS 

• Text:  Constant text or updated via VBScript 

• Text Variable:  Text updated by CHEMCAD 

GRAPHICS OBJECTS 

• Line:  Single line segment 

• PolyLine:  Multiple line segments end-to-end 

• Border:  Rectangular border 

• Arc:  Ellipse segment 

• Ellipse:  includes circle 

• Frame:  a kind of typical 3d border with a text title line 

• Bitmap:  allows you to bring a bitmap into your dialog 

• Gauge:  represents a double precision number as a gauge 
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• Pointer:  Pointer objects may not be used in user dialogs 

• Graph:  represents graphical data in your dialog 

CONTROLS 

• Button:  3D-enabled clickable button 

• CheckButton:  3D check box indicator 

• RadioButton:  Similar to CheckButton, used where there are multiple options 

• Combobox:  selects one of multiple options 

• ListBox:  displays a list of multiple text items 

• EditBox:  allows users to enter text 

• EditLongBox:  Allows users to enter integers 

• EditDblBox:  Allows users to enter real (double precision) numbers 

• Slider Box:  For selecting a value within a bounded range 

• Spinner Box:  Same idea as a slider, different look 

• ActiveX:  embed ActiveX controls in your dialog 

• OLE :  Embed an OLE object in your dialog 

 
GENERAL PROPERTIES  
Almost all objects have the following basic properties: 

Text Objects 

Text:  This simple object allows you to put text messages on your dialog.  The text properties can be 
changed using VBScript. 

 
A simple Text variable 
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Text Variable 

TextVar:  This is the Text Variable object.  CHEMCAD uses certain variables to store data such as the 
current engineering units or the current unitop ID number.  You can use the TextVar object to display 
these variables.  Available variables include: 

• Current engineering units labels  

• Unitop ID number 

• Component names from the component list 

• Variables from the Unitop array 

• Inlet stream ID numbers (inlets to this unit only) 

• Outlet stream ID numbers (from this unit only) 

• Generated from a VBScript 

A full list of variables is given in Appendix A. 

To set the value of the Text Variable, you must set the property labeled “Value_EQ”.  Double-clicking on 
this property will bring up the VBS editor to change your setting. 

 

 
Setting the TextVar to display pressure units 

Graphics Objects 

Without graphics objects, every dialog box would be a bewildering collection of controls, with no 
apparent organization.  Graphic objects, when used properly, help define your dialog and organize the 
controls and text. 

Simple Graphics 

Graphic objects allow you to display detailed graphics to help organize your dialog.  The basic graphic 
objects are Lines, PolyLines, Borders, Arcs, Ellipses, and Frames.   

Bitmap objects 

In addition to these simple objects, you may import bitmap files into your dialog using the bitmap object.  
Your bitmap file must be included in the same directory the MY file is located in. 
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Bitmap objects (arrows) in the batch operation dialog 

Gauge objects 

Gauge objects allow you monitor variables that will remain between a range of values, such as a liquid 
level.  Gauge objects are controlled by three main properties, MinimumEX, MaximumEQ, and ValueEQ.  
Set ValueEQ equal to the variable from the unitop array you wish to monitor.  MinimumEQ defines the 
0% point, MaximumEQ defines the 100% point. 

 

 
This gauge object is showing 34% full 

Pointer 

Pointers are not used in user added dialogs. 

Control Objects 

Most of the actual work of dialogs is done using control objects.  Control objects are the only objects 
which can directly change a variable in the unitop array.  These variables are listed by their number 
format and position in the array, i.e. “Double001” designates a Double precision number in position one 
of the array.  You must set the “ValueID” property of the control object to the variable you wish to control 
with it. 
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Button  

Button objects are designed to do something when pressed.  The following things can be done with a 
button object: 

• EventClick:  EventClick lets you customize the button to do whatever you wish.  When the 
button is clicked, it will run the script entered under the “EventClick”.  See the VBScript 
documentation for more details. 

• Goto:  Saves and closes this dialog, opening another dialog.  This is used to create multi-page 
dialogs, like the SCDS dialog 

• Help:  Opens the help system to a particular topic defined by the HelpContextID property. 

• OK:  Saves the data and closes the dialog, passing the unitop array back to CHEMCAD 

• Cancel:  Closes the dialog without passing the unitop array back to CHEMCAD 

• Record:  Unused 

• Goto Modal:  Open a sub-dialog box, which will appear modally (like an error message, always 
on top) 

Buttons also have many different shapes: 

 

 
Three different button shapes 

Most buttons use the default ButtonShape, “Normal”.  Goto buttons, on the other hand, are typically set 
to either “Property Tab (Inactive)” or Property Tab (Active)”.   In this way, users can tab through multiple 
pages of a dialog, with each page as a separate MY file. 

For example the SCDS screen has five pages, accessed by Goto buttons: 
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Five buttons on the SCDS page 1 

This is done by having five MY files, all of the exact same size and shape, with different button shapes 
on them.  The five files are SCDS.MY, SCDS2.MY, SCDS3.MY, SCDS4.MY, SCDS5.MY.  The above 
screenshot comes from SCDS.MY.  If we look into SCDS2.my, we see the same buttons, only with the 
second button set as the active button. 

 
Five buttons on the SCDS page 2 

 When you double-click on the SCDS Icon in CHEMCAD, CHEMCAD opens SCDS.MY.  If you select 
any of the top buttons, SCDS.MY will close and another will open.  Clicking on the OK button in any of 
the screens will save the data back to CHEMCAD. 

Feel free to explore the example dialogs in the Examples\Dialogs directory for more examples of using 
button objects. 

One final note about buttons:  Each dialog should have at the very least, an OK button and a Cancel 
button.  Otherwise data transfer back to CHEMCAD will not be possible. 

CheckButton 

CheckButtons (also called checkboxes) are used as True/False indicators.  The Checkbox stores data 
as a Long Integer, and returns either a 0 (False) or a 1 (True) to the unitop variable array member listed 
in the CheckButton’s “ValueID” property.  This is used to turn dialog features on and off. 

RadioButton 

RadioButtons are used to select a single option from a list of a few choices.  Like the CheckBox, 
RadioButtons store data as long integers in the “ValueID” property of the RadioButton.  The available 
choices are listed in the “ListItems” property of the RadioButton.   

Combobox 

Similar to the RadioButton, ComboBoxes are used instead of RadioButtons when the list of choices is 
too long to fit in the dialog.  Like the RadioButton, the available choices are listed in “ListItems”. 

ListBox 

Not used in user dialogs. 



Screen Builder  CHEMCAD Version 5.1 

26 

EditBox 

EditBoxes are used to type in string data, they are not used much in user dialogs, because unitop arrays 
cannot hold string data, only float or integer data.  One approach to circumvent this is to reserve space in 
your MAP file for a number of integers, and use a VBScript to convert a string into those integers and 
back again. 

EditLongBox 

EditLongBoxes are used to enter integer values, such as the number of trays in a column, etc.  The 
value in the box is associated through the “ValueID” property to a member of the unitop array.  
Combined with a Text object showing a label, these are widely used in dialogs. 

EditDoubleBox 

EditDoubleBoxes are used to enter real (double precision) floating point numbers.  The value in the box 
is associated through the “ValueID” property back to the unitoparray.  These are normally used in 
conjunction with Text objects as labels and TextVar objects to display the units. 

Sliders and Spinners 

Sliders and spinners are used to select values from a range, they are not widely used in dialog boxes. 

ActiveX and OLE objects 

Implementing ActiveX and OLE are not currently supported in user dialogs. 
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APPENDIX A: ENGINEERING UNIT LISTINGS 
 
The following table lists available Engineering units, MAP and LAB file designation, and the Internal units 
used by CHEMCAD. 

Description MAP file abbr. LAB file number Internal units 

Area AREA 8 ft^2 

Cake resistance CAKE 18 ft/lb 

Crude flow rate CRUDE 17 BPSD 

Diameter DIA 12 inches 

Dipole moment DMOMENT 21 debyes 

Enthalpy rate QRATE 6 MMBtu/hr 

Enthalpy/Mass MHEAT 36 Btu/lb 

Enthalpy/Mole MOLEHC 34 Btu/lbmol 

Enthalpy/Mole or Enthalpy/Mass SPHC 35 Btu/lbmol 

Fouling factor (reserved) FOULF 37 hr-ft^2-F/Btu 

Heat (no time) HEAT 33 Btu 

Heat capacity mole or mass bases HEATCAP 38 Btu/lbmol-F 

Heat Flux HEATFLUX  Btu/ft2-hr 

Heat of reaction HREAC 10 Btu/lbmol 

Heat transfer coefficient HTC 9 Btu/hr-ft2-F 

Inverse liquid volume ILV 39 1/ft^3 

Length  LEN 11 feet 

Liquid density LDEN 13 lb/ft^3 

Liquid volume rate LVRATE 29 ft^3/hr 

Mass (no time) WTMASS 32 lb 

Mass flow rate MASS 16 lb/hr 

Medium resistance MRES 25 1/ft 

Molar flow rate MOLE 1 lbmol/hr 
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Mole (no time) WTMOLE 31 lbmol  

Packed column pressure drop PACKDP 26 in water/ft 

Power WORK 7 BTU/hr 

Pressure PRES 4 psia 

Pressure difference DELTAP 5 psia 

Solubility SOL 19 (cal/cc)^0.5 

Specific heat capacity (mass base) WHEAT 27 Btu/lb-F 

Specific volume SVOL 20 ft^3/lbmol 

Surface tension ST 15 dyne/cm 

Temperature TEMP 2 degrees R 

Temperature difference DELTAT 3 degrees F 

Thermal conductivity TCOND 28 Btu/hr-ft-F 

Time TIME 40 hr 

Vapor density VDEN 22 lb/ft^3 

Vapor volume rate VVRATE 30 ft^3/hr 

Velocity VEL 24 ft/s 

Viscosity VISC 14 cP 

Volume VOL 23 ft^3 

 
APPENDIX B: VARIABLES  FROM CHEMCAD 
 
The following is a list of variables CHEMCAD uses to communicate with the dialog screen.  These 
variables are typically used in TextVariable type objects or used to turn dialog features on or off.  For 
example, in the MIXE dialog, many of the control are visible only if AUTOCALC is turned on, or in 
VBSCRIPT, if “AutoCalc=True”. 

 

    IDS_VAR_DOUBLE300       "Double300" 

    IDS_VAR_LONG300         "Long300" 

    IDS_VAR_STR300          "a_String300" 

    IDS_C200NAME_STR        "Comp200Name" 

    IDS_MOLERATE_STR        "<MoleRate Str>" 
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    IDS_TEMP_STR            "<Temp Str>" 

    IDS_DTMP_STR            "<Del Temp Str>" 

    IDS_PRES_STR            "<Pres Str>" 

    IDS_DPRS_STR            "<Del Pres Str>" 

    IDS_ENTH_STR            "<EnthRate Str>" 

    IDS_WORK_STR            "<Work Str>" 

    IDS_AREA_STR            "<Area Str>" 

    IDS_HTC_STR             "<HTC Str>" 

    IDS_HRXN_STR            "<Hrxn Str>" 

    IDS_LENGTH_STR          "<Length Str>" 

    IDS_VAR_INS14           "Ins14" 

    IDS_VAR_OUTS14          "Outs14" 

IDS_DIA_STR             "<Diameter Str>" 

    IDS_LDENS_STR           "<Liq Dens Str>" 

    IDS_VIS_STR             "<Viscosity Str>" 

    IDS_SFT_STR             "<SurfTens Str>" 

    IDS_MASSRATE_STR        "<MassRate Str>" 

    IDS_CRUDE_STR           "<CrudeRate Str>" 

    IDS_CAKER_STR           "<Cake resis. Str>" 

    IDS_SOLUB_STR           "<Solubility Str>" 

    IDS_SPEV_STR            "<Spec. Vol. Str>" 

    IDS_DIPOL_STR           "<Dipole M. Str>" 

    IDS_VDENS_STR           "<Vap. Dens. Str>" 

    IDS_VOL_STR             "<Volume Str>" 

    IDS_VELOCITY_STR        "<Velocity Str>" 

    IDS_INVLEN_STR          "<Inv. length Str>" 

    IDS_PACKDP_STR          "<Pack DP Str>" 

    IDS_WHEAT_STR           "<Mass heat cap. Str >" 

IDS_TCOND_STR           "<Therm. cond. Str>" 

    IDS_LVRATE_STR          "<Liq vol rate Str>" 
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    IDS_VVRATE_STR          "<Vap vol rate Str>" 

    IDS_WTMOLE_STR          "<Mole (no time) Str>" 

    IDS_WTMASS_STR          "<Mass (no time) Str>" 

    IDS_HEAT_STR            "<Heat (no time) Str>" 

    IDS_MOLEHC_STR          "<Enth/mole Str>" 

    IDS_SPHT_STR            "<Enth/mole or /mass Str>" 

    IDS_MHEAT_STR           "<Enth/mass Str>" 

    IDS_FOULF_STR           "<Fouling fac. Str>" 

    IDS_HEATCAP_STR         "<Heat cap mole or mass>" 

    IDS_TIME_STR            "<Time Str>" 

IDS_XID                 "<ID>" 

    IDS_XNAME               "<XName>" 

 

IDS_AUTOCALC            "AutoCalc" 

    IDS_ELEC                "Electrolyte" 

 
APPENDIX C:  ADVANCED CONTROLS 
 
Many times, dialog boxes in CHEMCAD need advanced options for selecting components from a list, 
selecting a variable from another unit operation, or a stream property.  Advanced controls are 
combinations of controls we frequently use in our own dialogs to make our interface the best in the 
world.  This appendix explains each in detail. 

COMPONENT LISTS 
Frequently, users must select one of the components from the component list.  This is usually done with 
a combobox control.  The dialog box returns the ordinal position of the component selected (NOT THE 
COMPONENT ID NUMBER).  For example, the user’s flowsheet has the following component list 

62 Water 

41 Toluene 

40 Benzene 

The user selects Toluene from the combobox control on the dialog.  The combo box returns a 2 to the 
associated unitop parameter, as Toluene is the 2nd component in the list.  If the user selects no 
component, the box returns a 0. 
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SCDS screen showing a component selection combobox 

Basic Setup: 
To create a component combobox you must do the following: 

• In the MAP file, set up an integer parameter. 

• Set TheFrame/TheView-EventInitialize method to “LoadComponentList”. 

• Create the Combobox, and set the “ListItems” property to “CompList 0”.  Link the combobox to 
the parameter in the MAP file. 

ADDING TO THE MAP FILE 
This adds a variable for the component list to return a value. 

To add a parameter to your map file, add a line to the end of the MAP file as follows: 

[ParameterName]  [Number] FLOAT LONG 

Where [parameterName] is any string you wish and [Number] is the parameter number you wish to use.  
Make sure that the “DICTIONARY” specification at the beginning of the MAP file is equal to the largest 
parameter number. 

SET THEFRAME/THEVIEW-EVENTINITIALIZE 
This method loads the component list into memory for the dialog to use.   

Open the properties of TheView by double clicking on the dialog in edit mode.  Go to the “Events” tab, 
and double click on “EventInitialize”.  Set this to “C++ Action” and “LoadCompList” as shown: 
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Events Tab for TheView  

 

 
Selecting  “LoadCompList” for the event.   

 
CREATE THE COMBOBOX 
Create the combobox in the normal fashion using the controls palette.  After creating you combobox, 
double-click it to view it’s properties sheet.   Set the “ValueID to correspond to the MAP file entry, and set 
the “ListItems” to “CompList” value 0. 
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ListItems setting for a Component ComboBox 

Using this kind of control, users can select any component in their simulations component list.  
CHEMCAD will store the ordinal number for that component in the parameter listed in the MAP file. 

VARIABLE SELECTION BOX 
A variable selection box allows your dialog to select a stream or unitop property.  This is used in unitops 
like controllers. 

A Variable selection box control is actually made of several controls.  A Radiobutton control selects the 
type of object, stream or unitop.  An EditLong box allows users to enter the Stream/Unitop ID.  A 
ComboBox is used to select the variable from a list.  If the variable is a stream variable, another 
Combobox will be needed to select a component.  Finally, a hidden control is used to store the resulting 
integer value. 

SETTING UP A VARIABLE SELECTION BOX 
To create a variable selection box, we must do the following: 

Add parameters to our MAP file for: Unit/Stream selection, Unit/Stream ID, and Variable number.  We 
must also add two dummy parameters to our map file as placeholders for the Variable ComboBox, and 
the Component ComboBox. 

 
 
 
 


